Uniden’s Bear cat E-Scanner Plus 2.0

Uniden’s E-Scanner Plus programming and control software allows you to program and
control Uniden Bearcat scanners (BC785D, BC250D, BC780XLT, BC245XLT and
BC895XLT) viaacomputer.

E-Scanner Plus enables you to program trunked, digital and conventional frequenciesinto
your scanner (if those systems are supported by your model). In addition, you can enter
the frequencies manually into the computer or upload them from a software file, which
aready contains all the frequencies and talk groups for the entire city, county or state
automatically. Free files containing the trunked frequencies and talk group 1D’ s can be
found at ht t p: / / www. bearcat 1. conf fl eet. ht m

Members of Uniden’s Betty Bearcat Radio Club can download unlimited conventional
frequency filesfor your city, county and state, which can be loaded into the E-Scanner
and E-Scanner Plus programs. Non-members of the Betty Bearcat Radio Club can
purchase frequencies for your city, county or state at
http://www.bearcat1.com/etrunk.htm.

E-Scanner Plus allows you to control your scanner (to scan, search, etc.) through the
software program using your mouse versus the buttons on the scanner. When configuring
your channels you have the ability to turn ON and OFF features such as the Attenuation,
Beep, Delay, Lock Out, etc.
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E-SCANNER PLUS SECTIONAL OVERVIEW
E-scanner-Plus is divided into three distinct sections. Setup, Programming and Scanning.

1. Setup Section
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2. Programming Section
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Scanning is divided into two modules
A. The Upper “Basic” graphical
interfaceis avirtual display of your
scanner and acts much the same
as using your radio.
B. The Lower “Extended” area contains
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All of these sections are linked by a common interface screen called the “ Splash Screen”.
When you exit a section you return to the Splash Screen - which is the only place you can
exit or terminate the program.
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SCANNER SOFTWARE SETTINGS

After you've loaded E-Scanner software onto your computer, you now must configure the
software to communicate with your scanner.

AUTOMATIC CONFIGURATION

The“ Auto Configure’ button will automatically detect which Uniden Bearcat scanner is
attached to the computer, which communications port on your computer is attached to the
scanner viathe RS-232 cable, and what baud rate is being used on your scanner.

To launch “ Auto Configuration” follow the following simple steps:

1. From the Start Up screen select SETUPS or from the programming window, click on
FILESin the menu located at the top of the screen and then click on SETTINGS in
the drop down menu.

2. The CONFIGURATION pagein the SETTINGS menu option should be displayed on
your screen. To automatically configure the computer to match your Bearcat scanner,
CLICK on the Auto Configure button. Thiswill automatically configure the software
to communicate with your Uniden scanner.



Ej nm port Settings ﬂ
iC

n Autoload
Accept
Select Radio
~ Uniden BC395
Baud Rat C Part
¢ Uniden BC245 auanse s e
= Uniden BCFE0 i 9800 i+ Comm 1
' Uniden BC250 " Comm 2
" Uniden BCY85 o TEE " Comm 3
i~ Comm 4
Select Radio FIRST and then choose settings
Timing Delay . 005
’7 4 I I DI

3. Once the software has detected the model, baud rate and communications port
(Comm Port) settings, it will ask you if the settings are correct. If it correctly
identifies your Uniden Bearcat scanner, click on the Accept button.

If you exit without clicking Accept, the settings will not be saved and you will need
to re-configure the software next time you run the E-Scanner Plus program.

MANUAL CONFIGURATION

Y ou can a'so manually configure the software to communicate with your scanner.
In order to do so, you must select the model, baud rate and port settings.

1. Listed are the Uniden scanners supported by E-Scanner Plus. Click on the circle
located next to your Uniden model. (Always select your radio FIRST before
assigning other settings, as each radio has a unique setup.)

If you do not see your model of Uniden scanner with a data port, you will not be able
to program your scanner with this version of E-Scanner Plus. Check back soon
because we will be adding scanners as soon as we can. Eventually the E-Scanner
Plus software will be able to program all Uniden scanners with data ports. If your
Uniden scanner does not have a data port you will not be able to program your
scanner with this software.

2. Now you must select the Communications Port on your computer connecting to the
scanner.

3. Click on the baud rate that matches the baud rate on your scanner. (To see what baud
rate has been setup on your scanner, please refer to your scanners Owner's Manual.)

4. Click on the Accept button after you've manually made your selections.



If you exit without clicking Accept, the settings will not be saved and you will need
to re-configure the software next time you run the E-Scanner Plus program.

FREQUENCY SOURCE FILES

Frequency source files are files that contain City, County and State conventional
frequencies. Trunked system source files will contain frequencies, talk group ID’ s and
user name information. Both types of files (conventional and trunked) are formatted as
“Text” or “D-Base” files. The E-Scanner Plus program has one sample file containing
common conventional frequencies for police, fire departments, public safety
organizations, etc. You can usethisfile to see how easy it isto program your scanner
with Uniden’ s E-Scanner Plus software. Or you can download Free trunked frequencies
with talk group 1D’ s for systems |ocated in your area.

There are two ways to receive frequencies for your area formatted for the E-Scanner Plus
software:

1. You can download frequencies for your area (City, County or State) from Uniden's
Bearcat Radio Club, http://www.bearcatl.com/etrunk.htm

a. Click on the Files menu option, located at the top left of the program.
b. Click on the L oad Files menu option.

c. Click on SourceFiles.

d. Now scroll to the last menu option titled Download Frequencies From Bear cat
Radio Club

EjBeartat E-Scanner Files = E-Scanner,Sample_Source.txt - Radio = BC250 — & x|
Files Edit LoadjRead Radio Database View Help Debug Conw. DB Source Loaded  Exit

NEW - Clears Entire Lawer Database | Base | Mobile [ CallGion | Licenses City -
Load File » Load Bearcat (* TRT) Frequency files MaTIORITE
Save File » Personal Database Files Load Bearcat (* DEF) Frequency File MATIONWIDE
Print » TOOT Load Bearcat Trurk 10 {Combo Database) MATIONWIDE
Settings 000 sownload Frequencies From Bearcat Radio Club |MATIONWIDE
Exit GO0 e MATIONWIDE

HECH T T Tresunon e | | AIRCRAFT UNICOM CHANNEL MATIONWIDE -

[ Bank 3 )i Bark 10 I Sich Ranges B Misc.

I
=
=

Fec#t Freauency Description Delay Fecord | Mode | Steps | Tones Prigrity e

izl

7
2
3
4
5 |CHH#E
E
7
g

9 CH#S
10 [CHH# 10
11 [CHH 11
12 [CHH#12

13 CHH13
14 |CHH 14
15 [CHH# 15
16 [CHH 16
17 |[CHH 17
18 |CHH# 18
19 [CHH#13

A o An

[ a4 fafaa]q]a

_LLLLLLLLLLLLLLLLLLLg

A [ A A A

ALLLLLLLLLLLLLLLLLLLE‘

=
{5 (o ()
Ul fa 4| fafa]a]afafafafa]4]a]afa]a]q
Ul fa 4 fafafafafafafafafa]a]a]afa]a]q
_LLLLLLLLLLLLLLLLLLLE

o [

This is the: SOURCE File Database. CLICK a Record to Select or Unselect recards to be Inaded inta the LOWER DATABASE
[for Radio). HIGHLIGHTED records indicate selected



From there you can select Download Frequencies and Fleet 1 D’s, which will connect
you to a http://www.bearcat1.com/etrunk.htm where you can download trunked and
conventional frequencies for your Agency, City, County and/or State.
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2. From Mr. Scanner and Betty Bearcat CD-ROM Frequency Guides, you can save
the frequencies as “D-Base” files and load them into the program.
LOAD SOURCE FILE INTO E-SCANNER PROGRAM

Once you have received your source frequencies, you are now ready to load them into
the E-Scanner Plus program. Follow these instructions below:

1. Click on Files, located at the top of the program.
2. Click on Load Filein the drop down menu.

3. Move your mouse over to the Sour ce Files and select the type of source file you
received (Text “txt” or D-Base “dbf”).
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4. Find thefileyou received or Uniden’s Sample Source file and double click onit.
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The program will now load those frequencies (and talk group ID’sif it’s for a trunked
system) into the top section of the program. The top section displays your “Source Files”
and the bottom section represents the channels and banks of your Uniden scanner.

Y ou will place the frequencies located in the top section “Source File” and paste them
into the channels and banks located in the bottom section of the program.
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PROGRAMMING CONVENTIONAL FREQUENCIES

Now that you have loaded the “ Source File” into the top section of the E-Scanner
program, it is now time to select the frequencies you would like to monitor and place
them where you would like them to be stored in your scanner’s channels and banks.

Y ou can program the scanner’ s banks to reflect your monitoring preferences.

For example, you may want to program each bank for a different city: Bank 1 is Dallas,
Bank 2 is Fort Worth, etc. Y ou could also program the banks based on the type of
monitoring you want to do: Bank 1 could be programmed for Police, Bank 2 for Local
Fire Departments, etc. This software alows you to easily program your scanner to match
how you prefer to monitor communications.

To load the frequencies into the bottom section, which represents the channels and banks
of your scanner, follow these instructions:



1. Click ona*“Bank”, located in the middle of the screen that represents the location
of where you would like to place the frequencies. (Bank 1, Bank 2, Bank 3 etc.)
See picture above for areference.

2. Scroll through the frequencies located on the top half of the E-Scanner Plus program

and click once to highlight the frequencies you would like to monitor.
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3. Onceyou've selected al the frequencies you would like to monitor in that bank,
click on the Edit menu option on the top menu bar.

4. Select Paste Highlighted Frequenciesto L ower Bank.

E7}Bearcat E-Scanner Files = E-Scanner'Las ¥egas Fire Department.556 - Radio = BE2 & x]
Fies | Edit Load/ReadRadio DatabaseView Help Debug TrunkDB Source Loaded Exit
Faste Highlighted FREGLERC atabase FleetiD User [ Shate | Gy Ty~
Paste Highlighted FLEET IDs to Lower Database
Paste CLIPBOARD Lower Database Bank Curl+y
select All Records in Source File
e e S A S S T T T o o
Move a Bank te fnother bank A5 [600-9_|HENDERSON FD [CHAMMEL 2] |[HENDERSOM [NV [l
Erase records in Selected Lower Bank 45 (1002 |COAVIATION DEFT CONT CTR|LASVEGAS [NV |1l -
Other » L
) T EALY T Sich Hanges T Misc.
Bank 5 1 Bank 5 1 Bark 7 1 Bank ©
Bank 1 1 Bark 2 1 Bark 3 1 Bark 4 ]
1
Bec # Frequency Deescription Trunk [ATT | Delaw | Beep | Record | Mode | Steps | Tones | LD | Priority =
1 [CHET ]| ~[o O - - i
2 [CHH#Z =) ] > [N= ] - > »| o
3 [CH#2 =) ] ~| ] - - ~|
4 [CHE4 H |5 = - - -
5 [CHES ]| ~ o a ~ ~ i
£ |[CHEE ]| o I ~ - i
7 [CHE7 =) ] > [N= ] - > »| o
g |[CH#® =) ] ~| ] - - ~|
9 |[CH#9 =) ] ~| _ - - ~|
10 [CHE10 = = ~| ] > - =
11 [CHEN = 0 ~ | ] - - ~ [
12 |CHE12 =) ] > [N= ] - > »| o
13 |CHE12 =) ] ~| ] - - ~|
14 |CHE 14 H |5 = - - -
16 |CHE15 = = ~| ] > - =
16 [CHE1E = 0 ~ | ] - - ~ [
17 |CHE17 =) ] > [N= ] - > »| o
18 |CHE12 =) ] ~| ] - - ~|
19 |CHE 19 H |5 = - - - =
e : 0 — : = = — .

Move mouse over contiols to see "On-Line Help”



NOTE:

If you've highlighted/sel ected a frequency by mistake or would like
to de-select it, click on the frequency again and it will be de-selected.

Select only the amount of channels that can be stored in each of your
scanners banks, 30, 50 or 100 depending upon the unit.

If you do not fill the bank’s channels and then later decide to add
additional frequencies, the new frequencies will automatically be placed
in the open channels. It will not over-write previously stored frequencies.
In order to over-write previously stored frequencies, you must clear the
bank and then insert the new frequencies. To clear stored frequenciesin a
bank go to the Edit menu option and then select Erase Recordsin L ower
Bank.

Once you have programmed a“Bank” and are ready to program the next “Bank”, you
must clear the highlighted records chosen from the “ Source Files’. Go to Edit and then
select Clear all Highlighted in Source File.
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PROGRAMMING TRUNKED FREQUENCIES

For Programming Trunked Frequencies, start by following the same instructions as
described for “Programming Conventional Frequencies’ previously. However, once you
have pasted the trunked frequencies into the lower database, you must check the TRUNK
button to indicate it is atrunked frequency. Since both trunked and conventional
frequencies can be programmed into one bank, thisidentifies which frequencies are apart
of atrunked system.
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6 [CHHE 8567625 CO/LAS VEGAS FD I =] | = - - ~ |0
7 CHH# 7 857.4875 HEWDERSOM PD [CH [ = ~| = - - ~[ O
g [CHH# & 057 7625 CO/LAS VEGAS FD ) || ~ [ = - - ~ [0
3 [CHH#S 058 7625 CO/LAS VEGAS FD = ][ = > [ = - - ~ [
10 CHH10 |85 2625 CO/LAS VEGAS FD = ][ = ~[ o = - - ~ [0
11 CHH11  |859 4625 CO/LAS VEGAS FD = ][ = ~[ o = - - ~ [0
12 CHH#12 |859.9376 CO/LAS VEGAS FD = ][ = ~[ o = - - ~ [0
12 CHH#13  |860.2625 CO/LAS VEGAS FD = [ =] »| L1 [ - - ~ [0
14 CHH#14 |8E0.4375 CO/LAS VEGAS FD = [ =] »| L1 [ - - ~ [0
16 CHH#15 |860.4875 CO/LAS VEGAS FD () () bl |15 . - - > | =
16 CHH 16 |860.9375 CO/LAS VEGAS FD () () bl |15 . - - > | =
17 [CHH# 17 = ][ = »| L1 = - - ~[ O
18 CHH 18 = = ~| O = - - |
19 CHH#19 = = ~| O = - - |
] - _——

Move mousze over contrals to see "0n-Line Help"



PROGRAMMING TRUNKED SYSTEMSINTO THE SCANNER

After the frequencies for atrunked system have been placed and checked in the lower
section for channels and banks, you will now need to configure the type of system you
want the scanner to monitor; Motorola Type I, Type I, UHF/VHF, M/A-Com/Ericsson
EDACS Narrow, EDACS Wide, EDACS SCAT, or LTR.

To select the trunk type, you will need to move the lower aqua colored database
to the green Talk Group/Fleet ID section using the bottom scroll bar.

=18 x|
Files Edt Load/Read Radic DatabaseView Help Debug Trunk DB Source Loaded  Exit
Fec#t Settings Frequenc: Systemn FleatiD LUzer Cit State | Sps Ty &
4 »
[ Bank 3 T T Sich Ranges T tdisc.
[ Bank 5 1 )i Bank 7 1 Bank &
Bank 1 1 i Bark 3 il Bark 4 ]
1
Record | Mode | Steos | Tones |L/0O Group 105 Groun Descrition | Trunk 55 Seftings =
1 s - - ~ = —
2 s ~ = B S
3 = - ~ | 0
t = i~ = Mot Type Il 300
=] - - ~| ot Type
g — = z = Mot Type Il LIHF
Mat Type Il YHF
7 R . : hd EDALS 'Wide
8 o - v -
3 s - - -
10 ~ = B S
11 = - ~ | 0
12 = - ~ |0
12 ~ = 1
1400 - - o
15 o - v -
16 _ - hd - | | OFF
17 - - -
18 o = = hd S MOT Fleet Map
JERES - - ~|O Block 0 =
- 0 = - — i IR )
4 LlJ

Mave mouse over controls to see "On-Line Help"

Note: You can locate the Trunk System Type information from
http://www.bearcat1.com/fleet.htm or from other sources located on the internet.

Motorola Type| Trunked Systems: 0 Bkt

an Trunk 575 Settings

Y ou will need to program the “Mot Fleet T Fot o
3yt Block 0
Map into the program. Block 1 Szed
Block 2 Size 4
Block 3
Block 4 Size 9
Block 5
Block 6 Size 4
Block 7
Block &
Block 3
Block 10
MOT Base Config #1
Frequency

-

L0l K0 £ EX R [ER ENENENER K]

Sten

3ASE



Motorola VHF/UHF Trunked Systems

To properly track Motorola VHF and T e
UHF trunked systems you must enter B Trurk 575 Settings
what is known as the Base I
Configuration. The Base Configuration

is comprised of the Spacing Frequency,
Step and Offset Channels for each

Wgan MDT&:EZ;DCTQ #2

Step

Step

Offset Chan

Offset Chan

Motorola YHF AUHF
OFFSET

-

CTHRL Chan HEX Walus
-

EDACS Trunked System Frequencies

When you program EDACS frequencies, it is critical that you store each onein the
CORRECT LOCATION. By the nature of EDACS systems, thisis necessary for
tracking. This often is not the frequency order, so you must be sure you have the right
sequence. Sources for this information can be found at http://scanner.uniden.com/.




PROGRAMMING TALK GROUP/FLEET ID’'S

Once you have loaded the trunked frequencies and configured the trunked system type
in the lower channels and banks section, you are now ready to load Talk Group/Fleet ID’s

into the lower channels and banks section.

1. Clear the highlighted frequencies in the upper source section. Go to M enu on the top
menu bar and select Clear All Highlighted Recordsin Source File.

NI
Files ’ﬁ Load/Read Radio Database View Help Debug  Trunk DB Source Loaded  Exit
Paste Highlighted FREQUENCIES to Lower Database f FleetlD Uzer Cih Slate | Sy Ty
Paste Highlighted FLEET IDs ko Lower Database
Faste CLIPEOARD Lower Database Bank Chrl+y
Select All Records in Source File
Clear All Highlighted Records in Source File
Move a Bank o Another bank
Erase records in Selecked Lower Bank x
Other b
Bark 3 I Bark 10 T Sich Ranges T Misc.
Bark 5 1 BarkE i Bark 7 1 Bark &
Bank 1 I | Bark 3 il Bank ¢ ]
1
Fecord | Mode | Steps | Tones |L/O Group DS Grouo Descrintion Trunk 575 Settinas =
1 [ - - | O Trunk Sestem Type
2 [ - - | O Aot Type |
3 - - ~|
4 = hd - hd | 15
5 - - ~|
[ =] - - b |15 MOT Status Bit
7 = - - ~| O OFF
a | | - - -
] [ - - - | O totorola -CALL
10 Eus hd = d L] OFF
11 - v -
12 O hd hd hd S Matorola End Code:
130 4 - - ~ [0 OFF
14 o0 - v -
15 o hd hd hd S hotarala Chil Chan
16| -1 hd - |0 OFF
17 = - - bl [ 5]
1|84 hd hd bl IS MOT Fleet Man
19 o hd hd hd S Elock 0 Size &

Maove mouze over controls to see

"On-Line Help"



2. Looking at the sixth section of the upper source database titled “User”, select the

users you would like to monitor by clicking once on the listing.

Talk Groun/Fleet 1D User
EjBearcat E-Scanner Files = E-Scanner'Las Yegas Fire Departmenk 556 - Radio = BC250 = 5'
Files Edit Load/Read Radio Database Wiew Help Debug Trunk DB So Loaded Exit
Fec # Settings Frequenc: System FleatlD Uszer Cit State | Sps Ty =

Rec #16 857.4875 CLARK CO./LAS VEGAS |B00-3  [HENDERSON PO [CHAMMEL 2] |HENDERSOM MY i
Rec#d 857.7625 CLARK CO./LAS VEGAS |41808  |CO/LAS VEGAS FD EMS CONTR |LAS YEGAS My i
Recf8 858.7625 CLARK CO./LAS VEGAS 41010 |CO/LAS VEGAS FD EMS CONTR |LAS YEGAS My i
Rec# 7 859.2625 CLARE CO./LAS VEGAS |41264  |CO/LAS WEGAS FD AIRPORT LAS WVEGAS My i -
| ¥

[ Bank 9 T Bark 10 T Sich Ranges T Iisc.
[ Bark 5 1 Bark i Bark 7 1 Bank &

Bank 1 1 Bank 2 1 Bank 3 1 Bark 4
Fecord | Mode | Steos | Tones |LA0 | Priority Giroup DS Grouo Descriotion Trunk 55 Settings

1 (] - - ~| Trunk Sestem Type

2 [ - - L ) Mat Tupe |

el O - v -

4| O - - ~ |l

5] o ~ = B S

53 = hd - |0 MOT Status Bit

7 RS = = x| OFF

g | - - -

g =] - - |z Motorola |-CALL

0, ! - - ~ | O 0FF

1 ~ = -

12 r hd - ~|= Matorola End Code

13 = - - - | QFF

14 = - - bl [ 5]

15 O hd hd hd S Motarala Chil Chan

I - - - | FF

17 = - ~ | 0

16 o = = hd 5 MOT Fleet Map

19 [ - - L ) Block 0 Size 8
= 0 = - e TR
Move mousze over contrals to see "On-Line Help"

MANUALLY ENTER FREQUENCIES

To manually enter frequencies, place
your mouse over the channel in the
“Frequency” column where you would
like to enter the frequency and double
click.

Y ou will seethe cursor begin to blink.
Go ahead and enter the frequency and
when finished press Enter on your
keyboard.

Note: Frequencies cannot be
changed/edited in the upper source
database with this program.

F7\col 2 Row 17 ==l x|
Files Edit Load/ReadRadio Database Yiew Help Debug Trunk DB Source Loaded Exit
Flec B Seftings|___Frequenc S pstem FleetD Uset Cit State | Sy Ty~
Fiec 16 8574875 CLARK CO./LAS VEGAS [B008 |HENDERSON FD [CHANNEL 2] |HENDERSON [NV [
Frec #9 57,7625 CLARK CO./LAS VEGAS [41808 | CO/LAS VEGAS FD EMS CONTR |LAS YEGAS [NV |1
Fiec 8 858.7625 CLARK CO./LAS VEGAS [41010 | CO/LAS VEGAS FD EMS COMTR |LASVEGAS [NV [
Flec 7 53,2625 CLARK COL/LAS VEGAS [41264 | CO/LAS VEGAS FD AIRPORT | LASYEGAS [NV |l -
1 »
i Bank 9 T Bank 10 1 Sich Ranges T Misc,
[ Bank§ )i Bark & 1 Bark 7 1 Bank 8
Bank 1 1 Bark 2 Bank 3 1 Bark 4
1
RAec# | Freauency Description Turk [ATT [ Delay [Beeo[Record [ Mode | Steos | Tones [L/0 [ Prioi [ 1] =
1 CH#1 [8557125  |HENDERSON FIRE D Wil e o [ - - [
2 [CH#Z [8962125 _ |HENDERSONFD [CH I ] £ [ - - -
3 [CH#3 25 |CO/LAS VEGAS I £ [ - - [
4 [CHid 75 |CO/LAS VEGAS I =3 [ - - <
5 CHilS 25 |CO/LAS VEGAS I £ [ - - ~
& CHHtG 25 |CO/LAS VEGAS I £ [ - = -
7 [CH#t7 HENDERSON FD (CH B[] ~ [RoR D - ~ = O
8 [CH CO0/LAS VEGAS B[ o [ - ~ ==
3 [CH CO0/LAS VEGAS B[] £ [ - - -
10 [CH CO/LAS VEGAS B (5] £ [ - - -
11 [CH CO/LAS VEGAS B [ £ [ - - =
12 [CH CO/LAS WEGAS I ] ~| ] - - >
13 [CH 860.2675 |CO/LAS VEGAS B | £ [ - = -
14 [CHETA C0/LAS VEGAS B[] ol [ - = -
15 [CHit 27 |860.4875 NQU/LAS VEGAS FD B[ o [ - ~ ==
16 CHyflE [880.9376 | CW/LAS VEGAS FD S T} 1 I ~ - =
17 CHE17 [156] 1 E (= e I - - e
18 [CH18 ] T ] ~| H - - ~[
19 [CHN1S 1 ,[ pT ] ~| = ~ - ~ | L
T [ i, 3

|E|i-:k on any of these tabs to change to another bank.



MANUALLY ENTER CHANNEL AND TALK GROUP ALPHA TAGS

To manually enter channel and talk
group aphatags, place your mouse over
the channel and “Description” column
or “User” (Tak Group) column in the
lower database and double click.

Y ou will seethe cursor begin to blink.
Enter the Text or Alpha Tag for the
channel or user. When finished press
Enter on your keyboard.

Note: Alpha Tags cannot be
changed/edited in the upper source
database with this program.

E7lCol 3Row 17 =lEx|
Files Edit Load/Read Radio Database Wiew Help Debug Trunk DE Source Loaded  Exit
Fec & Seftings]  Frequency Spsie FleetlD User Ci State | Gps Ty
Fec B 17 =~ CLARK CO./LAS VEGAS [1002 |00 AVIATION DEFT CONT CTR |LAS VEGA N
Fec# 16 CLARK CO./LAS VEGA! 0 AVIATION DEPT CONT CTR_|LAS VEGA! v sl
Fec# 19 CLARK CO./LAS VEGA! AVIATION DEFT. CUSTODIAL | LAS VEGA! N
Fec # 20 CLARK CO./LAS VEGA! O AVIATION DEPT ESCORT __|LAS VEGA! N
Fec & 21 =~ CLARK CO./LAS YEGAS [1004 |00 AVIATION DEFT (MAINT) __|LAS VEGA: N
Fec & 14 B55.7125 CLARK CO./LAS YEGAS [41232 |HENDERSON FIRE DEPT DISP _|HENDERSON [Ny -
4 »
i Bank 9 1 Bark 10 i Srch Ranges 1 Misc,
[ Bark § 1 Bank § )i Bank 7 Bank 5
Bank 1 1 Bank 2 1 Barlk 3 1 Bank 4
1
Fec# | Freouence Deserintion Tk [ATT [ Delav | Beeo [ Fevord | Mode | Steos | Tones [L/0 [ Frioiw [ [T+
1 [CH#1 [B55.7125  |HENDERSONFIRE D I = I - - = o
2 [CHE2 |9562125  |HENDERSOMPD [CH Iz £ [ - - 1
3 [CH#3  [B96.2625  |COJLAS VEGASFD I = I - - = o
4 [CH#4  [8564375  |CO/LAS VEGASFD Iz £ [ - - 1
5 [CH#EG [B96.7125  |CO/LAS VEGASFD I = I - - -
6 [CH#G |8557625  |CO/LAS VEGAS FD Iz £ [ - - 1
7 [CHET |B57.4875  |HENDERSONFD (CH I = I - - -
5 [CH#B |857.7625  |CO/LAS VEGASFD Iz £ [ - - 1
9 [CH#S  [B90.7625  |CO/LAS VEGASFD I = I - - = o
10 [CHET0 [858.2625  |CO/LAS VEGAS FD Iz £ [ - - 1
11 [CHET] [853.4625  |CO/LAS VEGAS FD I = I - - = o
12 [CHET2 (8589375 |CO/LAS VEGAS FD Iz £ [ - - 1
13 [CHE13 [860.2625  |CO/LAS VEGAS FD I = I - - -
14 [CHET4 (8604375 |CO/LAS VEGAS FD Iz £ [ - - 1
15 [CHE 15 [B60.4875 | COLAGMRGASFD I = I - - = o
16 [CHE 16 960937577 |LO/LAS YEGAS FD Ny v | ~| 1 - -~ -
17 [CHET7 [156.39f  [LAS VEGAS] AY T [ = I - - = o
18 [CHE1E [\ i ~| 1 - = = =
19 [CH# 19 \ S I ~| 1 - ~ g ) .
T — —— - = = = - = = = = ;
fick on any of these tabs to change te andher bank

|E

SOURCE FILE FREQUENCY COUNTER

To find out how many frequencies you have selected, ssimply place the mouse over the

Sour ce File of frequencies displayed in the top half of the program, and don't move the
mouse. The program will automatically indicate how many frequencies you've selected
to be programmed into the specified bank below.

In addition, it will tell you the total number of frequencies listed in the “ Source File”
and how many total frequencies you've selected for all channels and banks.

SORT SOURCE FILE INFORMATION

The information in the top database can be sorted in ascending or descending order

to ease your selections:

1. Placethe mouse on a“Column” title to sort.

2. Tosort in Ascending order, left click the mouse.

3. Tosort in Descending order, right click the mouse.



MOVE OR COPY BANKS

To move one Bank to another location:

1. Click Edit option from the top menu bar.

2. Click Move a bank to another bank.

3. Input the number of the bank you want to move in the box titled “ Source”.

4. Input the number of the bank where you would like the frequencies to be stored in the
box titled “ Target”.

5. If you want to copy, check the option Copy - the Source bank will be retained. If you
want to move, check the option M ove - the Source bank will be del eted.

6. Press Accept (or) Cancel to abort.

Ej E-Scanner Files = E-Scanner'Sample_Source.txt - Radio = BC250 - Se - |E||i|
Files Edit Load Radio Help Exit
Rec # Base —Eopya’Move Bank to another Bank Licenses -
Fec # 83 156.2750 5 |2_ IRIME PORT OPERATIONS MATIOMN W
Rec 40 156.5250 BuIEE IARINE PORT OPERATIONS NATIDNY
Target Iﬂ I4RINE COMMERCIAL OPERATIONS
+ Copy = Move )
Cancel | Accept |
[ Bank & 1 Bark 7 T Bank & i Bank 9 1 Bark 10
Bark 1 | Bank 2 1 Bark 3 ) Bark 4 i Bark 5
Rec # Frequency License Mame -

CH#101 1227000 AIRCRAFT UMICOM CHANMEL _

CH #1102 1225500 AIRCRAFT UMICOM CHANMEL

CH #1023 146.6400 AMATEUR T'wWi METER REFEATER

CH#104 146.7000 AMATEUR T'wi METER REPEATER

CH # 105 146.7300 AMATEUR T'wiO METER REFEATER

CH# 108 146.9100 AMATEUR T'wWi METER REFEATER

CH #1107 1523150 T CAR COMPANIES

CH #1085 1523450 Téu|CAR COMPANIES

CH#109 1623600 T CAR COMPANIES

CH#110 154.1600 FIRE DEPARTMENTS

CH# 111 154.1750 FIRE DEPARTMENTS

CHH#112 164.2050 FIRE DEPARTMENTS

CH#113 154.3400 FIRE DEPARTMENTS ;I.

Thiz iz the PERSOMAL File Databagze -DOLBLE Click on Record Selects # Ungelects "Trunking Assignment” - Press "INS" key to Ingert
Fecord - Press "DEL" to Delete Record - RIGHT CLICK to edit record.




PROGRAM FREQUENCIESINTO SCANNER

After you have placed the frequencies into the lower bank, it is now time to transfer
those frequencies into your scanner. Each bank must be transferred to your scanner
one at atime.

Note: For Trunked Systems, you will need to load both Frequencies and Fleet ID’s.
See “PROGRAM FLEET ID’sINTO SCANNER below.

1. Select the “Bank” you want to transfer to your scanner.
2. Click on L oad/Read Radio from the top menu bar.

3. Select Load Fregsin Selected Bank to Radio.

£71C0l 3 Row 17 =18 x|
Files Edi | Loag/ReadRado DatabaseView Help Debug Trunk DG Source Loaded  Exic

— User City [ State | Sps Ty <
Recf17  Load Fleet s in Selected Bank to Radio DEPT CONTCTR [LASVEGAS |Wv [Ui
Fec 18 Load search ranges DEFT CONTCTR_| L
FecH13  Read Frequencies from Radio to Selected Bank FT_CUSTODIAL _|LA¢
Ao #20  Read Fleet IDs fromRadia ko Selected Bank DEPT ESCORT LA
Rec 121 Read SearchRange DEPT MAINT] LA
e 14 T T i==ziysege) FIFE DEFT DISF_|HE
< v
[ Bank 9 i Bank 10 T SrchRlanges T Misc.
[ Bark 5 1 Bark & 1 Bark 7 T Bank 8
Bank 1 T Bark 2 T Bark 3 1 Bark & )|
1
Desciplion Turk [ATT | Delow | Been | Recod | Mode | Steos | Tones [L/0 [ Prioit [ 1] <
1o HENDERSON FIRE D = o i s [
2 o HENDERSON PD (CH = o I = ~ T
3 [0 CO/LAS VEGAS FD = 3 I S ~
4 [0 C0/LA5 VEGAS FD H o I = ~ [
5 [0 COJLAS VEGAS FD B o I -~ -
6 0 C0/LA5 VEGAS FD H o I e =
7 CH o o I = ~
|8 JEH k] { -l - o~
3 [0 H g5 & & B B ~li=
10 [CH o o [ -~ ~
11 [0 H o I e ~ [
12[c 5 o I -~ -
13 [0 B o I e =
14 [ = o I = ~
15 |0 = o N S ~
15 [0 o 2 T S ~ [
17 [ H 5 o I -~ <
18 [CF B[ o I e ~ [
19 [ B = o I -~ ~ [ -
JT - = - >
| Mave mouse over controls to see "On-Line Help”
£~ Bearcat E-Scanner Files (8]
Fies Edt Load/ReadRado Databaseew Help Debug Abort Loadng Ext
Feo # Settings|_Frequenc, e FleetD User Cit State | Sys Tye
et 17 ~ CLARK C0./L#5 VEGA: 00 AVIAT CONT CTR_| A5 VEGA T [
o ~ CLARK C0./L#5 VEGA! G0 AVIAT CONT CTR_|LAS VEGA: v |
o ~ CLARK C0./L#5 VEGA! [ATION STODIAL | LA VEGA: T [
o ~ CLARK C0./L#5 VEGA! G0 AVIATION DEFT ESCORT __[LAS VE GA T [
o ~ CLARK C0./L#5 VEGA! G0 AVIATION DEFT MAINT] __[LAS VEGA! I [
Feoi1a 655 7125 5 LHENDERSON T i -
Bark 9 Press ESC or CANCEL to sbart
Bank 1 Sen Ounasbionca T Dk _IEE"“‘
o NDTE = Sieos | Tores |L/0 | Proiiu] 4]
i Erapty records wil ease thase chansks in the Fladio CI £ =
2 [o &1 ~
3 [ 1 ~
4 [C [856.4375  |CO/LAS Vicen — — - £
5 [o [e56.7125 [ CO/LAS VEGAS o S T 1 <
6 LA VEGA 5 ~[o o £ <
7 H 5 £ T = <
g LA VEGAS 5 £ N = =
9 LAG VEGAS 5 o T 1 -
10 0 LAS VEGAS 5 £ I 1 ~
11 [CHET LAS VEGAS B £ I - ~
12 [c LA5 VEGAS B £ T 2 ~
13 [c L5 VEGAS o S T 1 <
LAS VEGA 5 ~[o o £ <
LAG VEGAS o £ T = <
LAS VEGAS 5 £ N = =
VE B[ o T 1 -
g B £ I 1 ~
g B £ I - ~

Pove mouse ver contios to see On-Line Help”



5. Next you can add an alphatag for labeling the Bank. If your scanner can support this
feature, you will be able to see the text label on the scanner.

Files Edi Load/Re Database View Help Debug Abort Loading  Exit

Fec® __[Sellings|  Frequency E FizellD User o7 Siate | Gys Ty <
e 17 = i LAS VEGAS [ 1002 |0 AVIATION DEPT CONT CTR_|LAS VEGAS WV [T
e = i LAS VEGAS [1003 |0 AVIATION DEPT CONT CTR_[LASVEGAS Wi |
e = i LAS VEGAS [ 1005 | AVIATION DEPT CUSTODIAL _[LAS VEGAS [NV [l
e = i RS VEGAS [ 1006 |0 AVIATION DEPT ESCORT _[LAS VEGAS [NV __[Ii
e = i LAS VEGAS [ 1004 |0 AVIATION DEPT (MAINT) __|LAS VEGAS [NV __[Ii
o EEHES LA LA VEGAS | 41232 IHENDERSON FIRE DEPT DISP_|HENDERSON [NV [l ~
Iput Redio Bak Titl - Masimum of 16 characters M‘;‘

Bank 1

ancel
ot | Freauency —| Stes
CHi1 [@557125 |HENDERS -
[ [ss6.2125 HENDERS |Vegas Fire Departmen] -
O56.2625  [CO/LASVL -

]
>

1 - [
2 - <
3 - <
4 564375 |CO/LASVEGAS ] e I - e I
5 8567125 |CO/LAS VEGAS ] R [P (T - |
5 855,766 | C0/LAGVEGAS H £ U > 1
7 [867.4875 | HENDERSON FD [CH H ~o o - ~
8 Ci 8577675 | C0/LAS VEGAS B £ I > ~
3 [C [856.7625 |CO/LAS VEGAS = £ I k3 £
10 [Ct [8532625 |CO/LAS VEGAS = K3 [ - 3
1 953.4625 LAS VEGA g ~[o o - <
2 9539375 LAG VEGAS 5 ~o o - <
3 8602625 LAS VEGAS 5 £ U - =
4 8604375 LAG VEGAS 5 £ U > 1
5 8604875 LAS VEGAS 5 £ U ~ ~[
16 0 BA0.5375 | C0/LAS VEGAS B £ I > ~
17 [ 155385 ||LAS VEGAS [ e I - |
18 [CH#18 B ~o o = ~li=
19 [CH#13 B[] £ ~ =l =
ar - - - o]

| Tick on anp of these tabs to change to anther bark.

6. You will now see E-Scanner Plus program your scanner with the frequenciesin your
computer.

PROGRAM FLEET ID’'SINTO SCANNER
Now that the frequencies have been programmed into the scanner, you must now
program the Fleet ID’ s into the scanner. Each bank must be transferred to your scanner

oneat atime.

Note: For Trunked Systems, you will need to load both Frequencies and Fleet ID’s.
See “PROGRAM FREQUENCIES INTO SCANNER” above.

1. Select the “Bank” you want to transfer to your scanner.
2. Click on L oad/Read Radio from the top menu bar.

3. Select Load Fleet ID’sin Selected Bank to Radio.

X =18] ]
Fies Edt | Load(Read Rado Dotabase View Help Debun Abort Loadng Ext
Fieo J FieollD User Ci Stote | 5ys Ty =
] >
[ Bark 9 T Bark 10 T Sich Rlana: T Mise.
[ Bork 5 1 Bank b 1 Bork 7 T Bonk &
Bank 1 1 Bark 2 T Bark 3 T Bank 4 )
Fiecord | Hode | Steos | Tones | /0 |Prorts [ 1] Goan Lits | Grouo DS Giouo Dessiotion Trurk 575 Gelings
T - H i31E2 VEGAS Tk Sustem Tupe
7 ~ m e1784 VEGAS ol Tpe |
3 [0 - 5 041424 YEGA:
4 [ ~ o 041808 YEGA:
5 [ - = (AT YEGA:
6 [ - H 04113 ILAS VEGA MOT Stats Bl
7 [ ~ = 0e1104 JLAGVEGA OFF =
ol = I 01072 /LAS VEGA
9l 5 - o 01040 JLASVEGAS Miotorla [ CALL
o ~ 5 041008 JLAE VEGAS 3
o - 5 040576 /LAS VEGAS
= - o Hiotorola £ nd Coce:
13 - = OFF =
o ~ H Wiotorola Cil
= 2 B GFF
o ~ 5 WOT Fleet Men.
1 ~ H Block 0 SizeB v
- = oo
e T Conicls o see U Line Aol



3. You will now see the E-Scanner Plus program the Fleet ID’ s on the computer screen
into your scanner.

Note: The scanner display will not change as it did when programming the channels.

SAVE CHANNEL AND BANK SETTINGS

If you want to save the lower database then follow these instructions:
1. Click on Files.

2. Select Save Personal Database.

3. Choose a filename.

4. Click OK.

The next time you load thisfile, all the settings will be preserved.

PRINTING OPTIONS

From the “Source” database you can either print all frequencies by clicking on the Select
all Recordsin Sour ce File from the Edit menu option or you can print only the
highlighted records, which you select. Once you've setup what you want to print click
on the Print Upper Sour ce Database from the Files option in the upper menu bar.

Y ou can also print each bank individually or all the banks from the Print menu option
located under the Files option on the top menu bar.

AUTOMATICALLY LAUNCH SOURCE FILESAND PERSONAL SETTINGS
If you typically use the same “ Source Database” (placed in the top half of E-Scanner)

of frequencies for your City, County or State, E-Scanner can automatically load that file
into the program.

Uniden currently has the Sample Source file automatically loading into the top section.
In addition, if you use the same “Personal Database” (placed in the bottom half of E-

Scanner) of your favorite frequencies to monitor, E-Scanner can automatically load that
fileinto the program. Seeinstructions below to setup the automatic launch functions.



A. SOURCE FILE FREQUENCY DATABASE

1. Double click on the white input box located above the title “ Source Database” and
click on the Source Frequency Database (Source Frequency Database is the software
file containing frequencies for your City, County, State, NASCAR, etc.)

2. Thisfilewill now load automatically in the top section of E-Scanner when you start
the program.

B. PERSONAL DATABASE SETTINGS

1. Double click on the white input box located above the title “ Personal Database” and
click on the saved Personal Database of your choice. (Personal Database is the Saved
Personal Settings of the frequencies you programmed into the channels and banks for
your scanner using the frequencies from the Source Database.)

2. Thisfilewill now load automatically in the bottom section of E-Scanner when you
start the program.

If you want to turn off the Auto-Launch feature, simply click on the Check Mark located
in the check box next to the title “ Auto-Launch Database

MISALIGNED TEXT ON BUTTONSAND CONTROLS

If you notice some of the controls or text on controls misaligned, it may be due to your
Video display being set for “Large Fonts’. Changing your display settings to “ Small
Fonts” will cure this problem.

Tips: Pasting from Excel or similar 3" party database programs

One basic alignment of the Excel spread sheet should be adhered to for best
results. Frequency and Fleet ID columns and their descriptions should be next
to each other. IE: A-B or C-D

- Highlight the cells to be pasted into the Personal database

- PressCtrl + C to copy them to the clipboard

- Goto E-Scanner and click on the first cell where you want to start the “ Paste”

- PressCtrl +V

Copying acell or group of cells from one areato another area or bank of the
personal database grid.

- Highlight the cells to be copied

- PressCtrl + C to copy them to the clipboard

- Click on thefirst cell where you want to start the “ Paste”

- PressCtrl +V



- Itispossibleto copy an entire bank to another bank by highlighting the entire
bank to be copied and then pressing Ctrl + C to place the bank into the
clipboard.



